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Introduction
The aim of this document is to show you how to make the best use of some of the facilities in
Microsoft Word and, in particular, to save you time when using it.
Note that this document doesn’t include tips applicable throughout the Microsoft Office suite –
see the document Microsoft Office 2013 – Hints & Tips for details of these. The Office tips include
starting a program and opening files, customising the Ribbon and Quick Access Toolbar, issuing
commands from the keyboard, AutoText, quick methods to select text, and when to use the
mouse button rather than the keyboard.
Be aware that there are several other documents on using Word, including An Essential Guide,
An Intermediate Guide, Starting a Thesis, Finishing a Thesis, plus a host of Advanced Topics.
An example file WordHintsandTips2013.docx is available to accompany this document. This
covers many of the points raised in the notes and can be downloaded by clicking on the link
provided above.

Starting Word and Customising the Screen
Begin by launching Word, as usual:
1. Open the Start menu, choose All Programs then Microsoft Office 2013 and Word 2013 then press
<Enter> for a new blank document
Some very useful features are now hidden by default. These include the Ruler and some commands, many of
which are still accessible – if you know how.
To display the Ruler:
2. Move to the VIEW tab then click on the [Ruler] button
The Ruler is a very useful feature as it shows the paragraph indents and tab settings. It can be used to change
these settings and is a useful indicator of possible problems if the text in a document isn’t lining up properly.
Another useful feature on the VIEW tab is the [Split] button. This can be used to split the screen in two so that
you can view non-adjacent pieces of text. This can be used to move/copy text from one place to another
1. Click on the [Split] button on the VIEW tab – the screen divides into two equal areas but you can drag
the split up/down the screen as required
2. Use the scroll bars (arrow keys or [Page Up/Down]) to move the display up and down
3. Use the mouse to switch the typing position between the splits
4. Click on [Remove Split] (or drag the split line to the top or bottom of the screen) to remove the split
The Status Bar immediately above the [Start] button shows various settings, which you can customise:
1. Right click on the Status Bar – the Customize Status Bar pop-up menu appears
2. Turn on/off the elements required then click away from the pop-up menu
The tabs on the Ribbon and Quick Access Toolbar can be customised - this is covered in the Microsoft Office
Hints & Tips notes. One tab, the Developer tab, is hidden by default. This is a useful addition if you create your
own macros or want to produce a Form. To display this tab:
1. Move to the FILE tab then click on Options at the foot
2. Under Customize Ribbon, turn on Developer in the pane on the right – press <Enter> for [OK]
There are lots of other options you might like to set, some of which (e.g. AutoCorrect) are covered in the
Microsoft Office Hints & Tips notes. It’s worth looking through these when you have time, in case there is
anything you would like to change (e.g. the default file format and save location).
Another screen customisation you might like to set is the Zoom level. If you set this on an empty document, it
is carried forward as the default for all new documents. Individual documents, once saved, can have their
own Zoom setting, which is retained within the document itself. To change the zoom level:
1. Click on the [Zoom level] button (currently showing as 100%) in the bottom right of the screen
2. The Zoom dialog box appears in which you can set the zoom level to Page Width or Text Width press <Enter> for [OK]
Tip: It’s better to choose one of these settings rather than a fixed percentage as the zoom level then changes
automatically if task panes (e.g. styles or the clipboard) are displayed.

Further Key Combinations
Having to issue commands using the mouse and icons on the Ribbon (or via the right mouse button) can be
very inefficient. You often have to switch tabs on the Ribbon before you can access a command. Make good
use of key combinations to issue commands instead.
The commoner commands are covered in the document Microsoft Office Hints & Tips; here are some further
Word-specific ones:
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<Ctrl 1> - Single spacing <Ctrl 2> - Double spacing <Ctrl 5> - One-and-a-half spacing
<Ctrl 0> - Add/remove space before paragraph <Ctrl Enter> - Insert page break
<Ctrl l> - Align text left <Ctrl r> - Align text right <Ctrl e> - Center text <Ctrl j> - Justify
<Ctrl m> - Indent paragraph <Ctrl t> - Create hanging indent
<Ctrl => - Subscript <Ctrl +> - Superscript <Ctrl spacebar> - Remove formatting
<Ctrl >> - Grow font <Ctrl <> - Shrink font <Ctrl ]> - Grow 1 point <Ctrl [> - Shrink 1 point
Try the following:
1. Typing a few words then press <Ctrl r> - they appear on the right
2. Try <Ctrl e> for centred text then <Ctrl l> to return to left align
3. Type a few more words so that you have a paragraph of at least 3 lines
4. Press <Ctrl 2> (on the main keyboard) to double-space it then try <Ctrl 5> for one-and-a-half spacing
5. Finally, return to single spacing (press <Ctrl 1>) but then add space before it (press <Ctrl 0>)
6. Remove the extra space (press <Ctrl 0> again) then press <Ctrl Enter> for a new page
7. Type in a few words on the new page then double click on one in the middle to select it
8. Press <Ctrl => the word appears as a subscript
9. Press <Ctrl => again to return to normal
10. Now try <Ctrl +> (i.e. <Ctrl Shift =>) to make the work superscript
11. Press <Ctrl >> (i.e. <Ctrl Shift . >) to make the superscripted text larger
12. Finally, press <Ctrl spacebar> - the superscript and font size setting are removed
<Ctrl spacebar> can be used to remove any text formatting (i.e. anything in the Font group on the Home tab)
except for highlighting. This includes changes to the font itself.
As well as the simple <Ctrl> key presses, there are many others involving combinations of <Ctrl>, <Shift>
and <Alt>. Indeed, almost all the available commands can be issued through such key presses. You can even
set your own shortcut key combinations. To see the complete list of standard shortcuts:
1. Click on the [Microsoft Office Word Help] button (or, more simply, just press <F1>)
2. Type keyboard shortcuts into the Search box – press <Enter>
3. Select Keyboard shortcuts for Microsoft Word – click on the [Show All] button to see everything
Were you to print out the help file you would find it covered 19 pages (page 6 onwards is specific to Word)!
Not even the most experienced Word user can possibly expect to know all the key combinations but it may
be worth looking through them in case anything would be of particular use to you.
4. Close the Help window by clicking on its [Close] button
Here are a few of the more useful shortcuts:
<Ctrl Alt d> - Insert endnote <Ctrl Alt f> - Insert footnote
<Ctrl Alt m> - Insert comment <Ctrl Alt v> - Paste special
<Ctrl Shift a> - Capitals <Ctrl Shift d> - Double underline <Ctrl Shift e> - Turn tracking on/off
<Ctrl Shift c> - Copy text format <Ctrl Shift v> - Paste format
<Ctrl Shift w> - Underline words only <Ctrl Shift 8> - Show/Hide ¶
<Alt Shift up_arrow> - Move paragraph up <Alt Shift down_arrow> - Move paragraph down
Try out the following:
1. Press <Ctrl Shift 8> to show the paragraph marks then again to hide them
Being able to see the paragraph marks can be extremely useful; experienced users often work with them
displayed. They don’t print, by the way.
2. Press <Enter>, type in a few words then press <Alt Shift up_arrow> to move the paragraph up
3. Now press <Alt Shift down_arrow> to move the selected paragraph back down
4. Press <Ctrl Shift w> to underline just the words then <Ctrl Shift a> to capitalise them
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5. Finally, press <Ctrl spacebar> to revert to normal
Tip: An easy way to change a shortcut key combination is to press <Ctrl Alt +> (on the numeric keypad) - the
mouse cursor becomes a four-leaf clover. Now click on the command icon whose shortcut you want to
change and the Customize Keyboard dialog box appears, allowing you to set a new key combination. Try it, if
you like, but then press <Esc> or click on [Close] before making any changes.

Further Function Keys & Key Combinations
The simple use of function keys to issue commands is also covered in the document Microsoft Office Hints &
Tips; here are a few more, word-specific ones:
<F8> - Extend mode <F9> - Update field
<Shift F3> - Change case <Shift F5> - Move to last change <Shift F7> - Thesaurus
<Shift F9> - Toggle field code <Ctrl F2> - Preview <Ctrl F9> - Insert field
<Alt F9> - Toggle all codes <Alt F10> - Maximise window <Alt F5> - Restore window
To learn about field codes, see Microsoft Word: Fields. One useful key combination is <Shift F5>. This jumps to
the previous insertion point (even in another open document). To see this:
1. Press <Ctrl n> for a [New] document and type in a word
2. Now press <Shift F5> and you'll find you jump back to your original document
3. Type in a few words then press <Shift F5> again - you move back to the new document
4. Keep pressing <Shift F5> and watch what happens - finish on your original document
Another interesting facility is Extend Mode. With this, you can select text from the keyboard without having to
use the <Shift> key. To see this working:
1. Press <F8> to turn on Extend Mode
2. Use the <arrow> keys to extend the selection - <Ctrl arrow> speeds up the selection
You would now issue a command to the selected text but here:
3. Press <Esc> then an <arrow> key to release Extend Mode
Tip: If you press <F8> several times it selects a word, then a sentence, then a paragraph, then all your text!

Inserting Special Characters and Other Objects
You probably already know that Word has a wide range of characters which you can add to your text using
[Symbol] on the INSERT tab. Most of these can be typed in via the keyboard, as you will see in a minute. For
those that can't, you can set up your own special key combinations. There are also various other special
characters you may not be so familiar with - e.g. non-breaking hyphens and spaces, hard pages and soft returns.

Foreign Characters
Inserting special characters via the INSERT tab and [Symbol] button can be very time-consuming and it's
better if you can learn how to do so from the keyboard. For accented letters, the trick is to type the accent
using the <Ctrl> key, then follow that with the letter you require. For example:
1. Hold down <Ctrl> and type a comma, then release <Ctrl> and type c (for ç)
2. Hold down <Ctrl> and <Shift> and type a # then release <Ctrl Shift> and type n (for ñ)
Other examples include, <Ctrl '> for an acute accent, <Ctrl `> for a grave, while <Ctrl Shift ;> gives you an
umlaut. You can also set up your own shortcut keys for such characters:
3. On the INSERT tab, click on [Symbol] then More Symbols… and check the Font: is (normal text)
4. Scroll through the list of characters to find one you want to use regularly (e.g. ñ)
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5. Select the character then click on [Shortcut Key...]
6. Press new shortcut key: required - e.g. <Alt n>
7. Press <Enter> for [Assign] then <Enter> again for [Close] twice
8. Try out the new shortcut key - e.g. press <Alt n>
For some characters it's easier to use another keyboard (if the keyboard is installed) via the small icon on the
right of the Taskbar (bottom of the screen) currently shown as EN (for English) - e.g. KO for Korean symbols:
9. Click on the [Keyboard] selector icon and choose KO for Korean
10. Type the letter(s) you require (note that some keyboards may require extra icons/options to work)
11. Click on the [Keyboard] selector icon again and choose EN for English
Tip: You can install other keyboards by right-clicking on EN and choosing Settings...

Other Special Characters
Most users ignore the second tab in the Symbol window, but this has some useful characters:
1. On the INSERT tab, click on [Symbol] then More Symbols…
2. Click on the Special Characters tab and explore what's available (note the key combinations)
Of particular note are the Nonbreaking space and Nonbreaking hyphen. Use these where you don't want two
words to be split (i.e. one at the end of one line and the other at the start of the next). You can also insert an
Optional hyphen, which will only appear when needed. These can all also be inserted from the keyboard:
3. Press <Esc> for [Cancel] to [Close] the Symbol window
4. Complete the current line of text but press <Ctrl Shift Spacebar> (or <Ctrl Shift -> for a nonbreaking hyphen) instead of <Spacebar> (or <->) between the last two words on the line
5. As you keep typing the last word, note how both it and the previous word move to the new line
6. Press the <left-arrow> key to move back into the last word and press <Ctrl -> for an optional hyphen
– the hyphen should appear with the word splitting over two lines
7. Double click on the last-but-one word and <Delete> it – the hyphen should disappear
8. Type more text and watch how the hyphen appears/disappears as the last word moves between lines
Another special character is a page break. Use this whenever you want to fix a new page (e.g. for the start of a
new chapter of a thesis). To insert a page break:
9. Move the current typing position to the required place in the text then press <Ctrl Enter>
You can also insert page breaks on both the INSERT and PAGE LAYOUT tabs. Section breaks are used to split a
document into sections - e.g. if you want different page numbering or a landscape (sideways) page. Sadly
there isn’t a shortcut key for this, but you could create your own (e.g. <Ctrl Alt Enter>) by using the method
described in the tip on the previous page.
Another important character you may not have heard of is a soft return. This starts a new line without starting
a new paragraph and is useful in numbered and bulleted lists:
1. Press <Ctrl End> then <Enter> for a new line and click on the [Numbering] button on the HOME tab
2. Type in some text then press <Enter> - a new list item appears
3. Type in another line of text then press <Shift Enter> - this time you just get a new line
4. Type in some text then press < Enter> - another list item appears
You can use this method to get more than one paragraph under a single list item (e.g. on an exam paper with
numbered questions).
Not everyone is aware how numbered lists work, so try the following:
5. Press <Tab> and the numbering changes to a sub-level - add some text then press <Enter>
6. Press <Shift Tab> to restore the numbering level then type in more text - press <Enter>
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7. Press <Enter> again to turn off the numbering

Files and Objects
One of the buttons in the Text group on the INSERT tab is to insert an [Object]. Here, you can choose to
insert Text from File… or an Object… You should only use Text from File… if you want to insert a file in a
format Word understands - another Word document (*.doc), a Text file (*.txt), Rich Text Format (*.rtf) or a
Web Page (*.html). To insert an Excel chart, for example, choose Object... then Create from File.
You may be tempted by the [Chart] button in the Illustrations group. This allows you to draw a chart from
scratch, using the same charting facilities found in Excel. It doesn’t let you insert an existing chart.
To insert a [Picture] from a file or [ClipArt] use the other buttons provided in this group. Of course you can
always Copy and Paste pictures (and graphs) from their source into Word. When copying charts from Excel,
it’s a good idea to paste them as pictures. This can be done either by using Paste Special or by choosing this
option from the Paste Options button, which appears whenever you paste anything in Microsoft Office.
A new feature in Word 2010 is to insert a [Screenshot]. Click on the button to see the available windows. If
you want the whole window then choose it, otherwise choose Screen Clipping and drag a rectangle over the
area of the screen required.

Formats and Styles
Many users change the format of their text (e.g. font, font size, bold/italic/underline) or paragraph settings
(e.g. spacing, justification, indents) manually. It's much more efficient to use a style. Styles have other
benefits, as you will see.
<Ctrl Alt 1> - Heading 1 <Ctrl Alt 2> - Heading 2 <Ctrl Alt 3> - Heading 3
<Ctrl Shift n> - Normal style <Ctrl Shift s> - Apply Styles window
Styles are also available from the Styles group on the Home tab.

Heading Styles, Captions and Cross-Referencing
Word has hundreds of built-in styles, only some of which are shown by default. You can also create your own
styles. To see what's available:
1. Press <Ctrl Alt 1> and note how the font changes automatically from Calibri to Cambria while font
size increases from 11 to 14 - bold is also turned on
2. Type in a few words using the new style then press <Enter> - the style reverts to Normal
It's particularly important to use these styles whenever you are writing a long document (such as a thesis) as
Word uses them to generate a Table of Contents. You can modify the pre-defined settings - e.g. to change the
font or font size or justification. You can also automatically number your headings (e.g. 1.1, 1.2, 1.2.1, 1.2.2
etc.) by turning on multilevel numbering. To see this:
3. Press <up arrow> to move back into your heading then click on the [Multilevel List] button in the
Paragraph group on the HOME tab
4. Select the required numbering associated with the headings (e.g. 1 Heading 1)
5. [Center] the heading, if you prefer your main heading centred, and change the font if you want to
6. Finally, right click on the heading and choose Styles then Update Heading 1 to Match Selection
You have now redefined the heading styles. To test this out:
7. Move down to the end of your work (press <Ctrl End>), type a few words then press <Ctrl Alt 2> –
you should find them numbered (e.g. 1.1)
8. Now press <Ctrl Shift n> to return them to the Normal style
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Note that if your headings are numbered, you can press <Tab> (or <Shift Tab>) to increase (or decrease)
the heading level.
In the same way that Headings are used by Word to create a Table of Contents, Captions must be used to
generate a Table of Figures (or Table of Tables etc.). To insert a caption:
9. Move to the REFERENCES tab and click on [Insert Caption]
10. Using the list arrow attached to Label: select the type of caption required
Tip: If you require a different label (e.g. Map), click on the [New Label...] button - type in your Label: then
press <Enter> for [OK].
11. Press <Enter> for [OK] then type in the required caption (and press <Enter> for a new line)
If you want to refer to a particular numbered paragraph or figure/table, you should do so by using a crossreference. If the number then changes, so will the text referring to it in your document. To add a reference,
click on the [Cross-reference] button on the REFERENCES or INSERT tab.

The Format Painter
The Format Painter is used to copy the format (font and/or paragraph settings) from one piece of text to
another. Somehow, this extremely useful button is a mystery to most users:
1. Select the text/paragraph whose format you wish to copy - here, select a word in the main heading
2. Click on the [Format Painter] button to the right of [Paste] (the pointer becomes a brush)
3. Drag through another piece of text - release the mouse button and it becomes Cambria 14 bold
4. Next, click three times on the word in the main heading (to select the whole paragraph)
5. Click on the [Format Painter] button again then on a paragraph which isn't a heading - it too now
should be (this time you painted the format of the paragraph, not just of the text)
The Format Painter can also be used to sort out problems. If, for example, you have a paragraph which has
incorrect indenting or tabs set in the wrong place, locate a paragraph with the correct setting then use the
Format Painter to copy these across to the wrong paragraph.
Remember: <Ctrl spacebar> and <Ctrl Shift n> remove all formatting from a selected piece of text.

Tables
Tables offer a very useful layout for certain types of data and text. There are several useful tips you should
know about when using tables. To see these you first need to create a new table:
1. Press <Ctrl End> to move to the end of your document then press <Enter> for a new line
2. Move to the INSERT tab then click on the [Table] button and create a 5x3 table
Note that when creating a table, there is no need to set the exact number of rows. Tables expand to give you
an extra row when you press <Tab> in the last cell. If you didn't know this already, try it out later.
Moving around a table can be performed either using the arrow keys or the tab key. There are also key
combinations for quickly moving to the start/end of a column/row:
3. Type some text (a single word will do) in the first cell of the table then press <Tab>
4. Repeat step 3 but this time press <right arrow>
Note the difference between these. If you press <Tab>, the first letter of the word is capitalised; if you use
the <left or right arrow> key, it isn’t. Note that you can also use <Shift Tab> to move back a cell. Capitalising
the first letter is an AutoCorrect option which can be turned off if you don’t like it.
5. Next, press <Alt Home> to move to the first cell in the row (<Alt End> moves to the last cell)
6. Now try <Alt Page Down> to move to the last row (<Alt Page Up> moves to the top row)
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Selecting text can also be done using key combinations. Here, you also press the <Shift> key:
7. Hold down <Shift> and use <Alt Home/End> or <Alt Page Up/Down> to select columns or rows
You can also use the mouse to select cells/rows/columns. Most users drag through the cells they want, but
there are better and more precise ways of doing this:


To select a column, click at the very top of a column (the cursor shows as a black arrow)



To select a row, click on the far left (as you would to select a line in a paragraph)



To select a cell, click inside it on the far left (again, when the cursor is a black arrow)



To select the whole table, click on the table indicator – this appears immediately to the left and above
the first cell when you take the mouse cursor into the top of the table

To practice:
8. Try selecting parts of the table, as described above, then press <Alt Page Up> to move to the top row
You can also use the right mouse button inside a table:
9. Right click inside a cell and choose Insert then select what you want to insert (Columns to the
Left/Right or Rows Above/Below) – note you can also Delete Rows/Columns/Cells this way
10. Right click on the far left of a cell and choose Split Cells...
11. Press <Enter> for [OK] to split the cell in two vertically
Another important feature of a table is its properties. Individual cells can have their own property settings,
though it is more usual to set these up for a row or column.
12. Move to the TABLE TOOLS LAYOUT tab then click on the [Properties] button on the far left
13. Move to the Row tab and note the Options
Currently, a row can split across a page break, which is not good. Also, you can set the top row (or rows) as a
header, which is repeated if the table does break across two pages (note also the [Repeat Header Rows]
button on the right of the Layout ribbon). On the row tab, you can also set the row height:
14. Turn on the Specify Size: option and set a value of 1.5cm then press <Enter> for [OK]
Note how the row height has increased. Most people add extra blank paragraphs (by pressing <Enter>) to
achieve this but this is very bad practice. You can also turn on this option by using the [Table Row Height]
button in the Cell Size group. In the Alignment group to the right of this, you have nine alignment buttons,
which let you align the contents at the top, middle or bottom as well as left, centre or right.
Finally, here are a few useful tips about tables:


If you want to have a graphic with text running alongside it, create a one-row two-column (no
borders) table and place the graphic in one cell and type the text in the other



Avoid double-spaced text in tables - if you do need this then add spacing before the paragraph to
counterbalance the space below the text (click on the Paragraph group arrow then, on the Indents
and Spacing tab, increase Spacing Before:)



Double click on a column border to autofit the column to its content (or use the [AutoFit] button)



To use tabs inside table cells you have to press <Ctrl Tab>

Graphics
People often have trouble with graphics. Understanding exactly what's gone wrong is often not easy (see the
IT advanced notes on Microsoft Word: Graphics for further details). Here are just a couple of tips:


Be aware of text wrapping. This is how the graphic relates to its surrounding text. Right click on the
graphic, choose Wrap Text then go to the More Layout Options… tab to see the current setting
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Be aware of the aspect ratio. This preserves the shape of a picture so that as you change the height,
the width changes proportionally. This setting can be found by right clicking on the graphic and
choosing Size and Position…

The drawing facilities offered via the [Shapes] button on the INSERT tab should also be explored. To learn
more about these, see Microsoft Office: The Drawing Tools. Again, here are some useful tips:


When using any of the drawing tools, a Drawing Canvas might appear. To stop this happening, move
to the FILE tab, click on Options then, in the Editing Options on the Advanced tab, turn off
Automatically create drawing canvas when inserting AutoShapes



If you want to hide something (e.g. part of a picture or page number), draw a white rectangle over it,
setting the border style to No Line



To group several drawn objects into a single unit, hold down the <Shift> key and click on each in
turn then right click on one of the objects and choose Group followed by Group



You can align or distribute several selected objects using the [Align] button in the Arrange group on
the DRAWING TOOLS FORMAT tab (which appears whenever you click on a drawing object)



When creating a drawing you may need to bring objects forwards (or send them backwards). To do
this, right click on the object, choose either Bring to Front or Send to Back then the required
command

Leaving Word and Logging Out
End the session by closing down Word:
1. Press <Ctrl s> for [Save] if you want to save your work
2. Now press <Alt F4> (or <Ctrl F4> or <Ctrl w> to close a document but leave Word running)
If you have completely finished using the computer, a quick way to log off is to:
1. Press the <Windows> key (between <Ctrl> and <Alt>)
2. Press <right_arrow> (for Log Off)
3. Press <Enter> to confirm this
Tip: You can also use <Alt F4> to log off
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